
The iCommunicator 
User Guide

The iCommunicator™

Version 4.0 — User’s Guide 

Part No. IC6100047 Rev. A



The iCommunicator 
User Guide

This document is the copyright of PPR Direct,Inc. and is intended for exclusive use of PPR Direct customers. All rights 
are reserved. Information in this document is subject to change without notice. Companies, names, and data used in 
examples herein are fi ctitious unless otherwise noted.  No part of this document may be reproduced or transmitted in 
any form or by any means, electronic or mechanical, for any purpose, without the express written permission of PPR 
Direct,Inc.
  
© 2005 PPR Direct,Inc. All rights reserved
  
 The material in this document has been carefully reviewed; however, PPR Direct Inc. does not guarantee it to be free 
of all errors or omissions and reserves the right to make corrections, changes, updates, or revisions to the information 
contained herein. 
  
iCommunicator is a trademark of PPR Direct,Inc.
  
Other than those held by PPR Direct,Inc., any other brand and product names referenced in this manual are trade-
marks of their respective holder and are used here for informational purposes only.
  
PPR Direct,Inc.
74 20th St
Brooklyn, NY 11232
 



The iCommunicator 
User Guide

PPR Direct, Inc.
SOFTWARE LICENSE AGREEMENT

NOTICE TO LICENSEE:  READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY 
BEFORE OPENING THE PACKAGE CONTAINING THE PROGRAM DISKETTES, TAPE OR OTHER MEDIA, THE COMPUTER 
SOFTWARE THEREIN, AND THE ACCOMPANYING USER DOCUMENTATION (COLLECTIVELY THE “PROGRAM”), OR IF THE 
COMPUTER SOFTWARE IS PRE-INSTALLED, BEFORE USING THE PROGRAM. BY OPENING THE PACKAGE CONTAINING 
THE PROGRAM, OR OTHERWISE USING THE PROGRAM, IF THE COMPUTER SOFTWARE IS PRE-INSTALLED, YOU, AS 
THE LICENSEE (“LICENSEE”), ARE ACCEPTING AND AGREEING TO BECOME BOUND BY THE TERMS OF THIS LICENSE 
AGREEMENT. IF YOU ARE NOT WILLING TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT, PROMPTLY 
RETURN THE PACKAGE IN UNOPENED FORM WITHIN FIVE DAYS OF THE DATE OF PURCHASE TO RECEIVE A REFUND. 
THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE PROGRAM BETWEEN LICENSEE 
AND PPR Direct, Inc.(“LICENSOR”), AND IT SUPERSEDES ANY PRIOR PROPOSAL, REPRESENTATION, OR UNDERSTAND-
ING BETWEEN THE PARTIES. THE PROGRAM IS NOT SOLD TO THE LICENSEE, BUT IS THE PROPERTY OF THE LICENSOR 
PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL TREATY. ANY USE OF THE PROGRAM IS GOVERNED BY THE 
TERMS OF THIS AGREEMENT. KEEP THIS AGREEMENT IN A SAFE PLACE, AS IT IS YOUR PROOF OF PURCHASE AND MAY 
BE REQUIRED FOR UPGRADE OR SUPPORT SERVICES.

1. License Grant. Licensor hereby grants to Licensee and Licensee accepts a non-exclusive license to use the Program 
Diskettes and the computer programs contained therein only in machine-readable, object code form (collectively the “Software”), and 
the accompanying User Documentation, only as authorized in this Agreement. The Program may be used only in a manner autho-
rized by the manual, subject to the terms of this Agreement. 
 If the product confi guration for the Software that Licensee has licensed is designated as a “Single Machine License” on 
the Software packaging, the Software may be used only on a single computer owned, leased, or otherwise controlled by Licensee 
at a facility owned or leased by Licensee, or in the event of the inoperability of that computer, on a backup computer selected by 
Licensee. Neither concurrent use of the Software on two or more computers nor use in a system, multiple central processing units, 
emulations on a local area network or other network, or on a mainframe, micro or other central fi le or program server computer is 
permitted without separate authorization and the payment of additional license fees under a supplementary license.
 If the product confi guration for the Software that Licensee has licensed is designated as a “Location License” on the 
Software packaging, the Software may be used only at one geographic location owned or leased by the Licensee on any number of 
computers owned, leased, or otherwise controlled by the Licensee, unless otherwise restricted to a specifi ed number of computers 
by notice on the packaging.
 If the product confi guration for the Software that Licensee has licensed is designated as a “Server License” on the Soft-
ware packaging, the Software may be used only on a single server computer owned, leased or otherwise controlled by Licensee 
at a facility owned or leased by Licensee, and in connection therewith may be used in a related local area network or other intranet 
for any number of computers within the network, unless otherwise restricted to a specifi ed number of computers, network users or 
clients by notice on the packaging.
 Certain additional or alternative restrictions may apply to the license of this Software. These restrictions, if any, are printed 
on the Software packaging, and when present, form part of this Agreement.
 Upon loading the Software into the computers specifi ed by the terms of the product confi guration identifi ed on your Soft-
ware packaging, Licensee may retain the Program Diskettes that Licensee has received for backup purposes. In addition, Licensee 
may make one copy of the Software on a second set of diskettes, CD-Rom disks or cassette tapes for the purpose of backup in the 
event the Program Diskettes are damaged or destroyed. Licensee may make one copy of the User’s Manual for backup purposes. Li-
censee shall reproduce and include the trade secret and copyright notices and any other proprietary legends that are on the original 
Program in all copies, in whole or in part, of the Program. Except as authorized under this paragraph, no copies of the Program or 
any portions thereof may be made by Licensee or any person under Licensee’s direction, authority or control. Licensee agrees to not 
assign, sublicense, transfer, pledge, lease, rent, sell, or share any rights granted under this Agreement, unless otherwise expressly 
authorized in writing by Licensor. Licensee will not disassemble, decompile, reverse engineer, copy, alter, or otherwise use the Soft-
ware except as expressly authorized by this Agreement.
2. Restrictions. Licensee acknowledges and agrees that the Software and the User’s Manual, forms and other information 
supplied to Licensee by Licensor, and any copies thereof are proprietary products of Licensor protected under U.S. Copyright Law 
and International Treaty. Licensee further acknowledges and agrees that all right, title and interest in and to the Program, including 
associated intellectual property rights, are and shall remain with Licensor. Licensee agrees to take all reasonable steps necessary to 
protect the trade secrets and other property rights of Licensor. This Agreement does not convey to Licensee an interest in or to the 
Program, but only a limited right of use which is terminable in accordance with the terms of this Agreement. 
3. License Fees. The license fees paid by Licensee are paid in consideration of the licenses granted under this Agreement.
4. Term. This Agreement is effective upon Licensee opening this package and shall continue until terminated. Licensee may 
terminate this Agreement at any time by returning the Program and all copies thereof and extracts therefrom to Licensor. Licensor 
may terminate this Agreement upon the breach by Licensee of any term hereof, and shall have the right to injunctive relief enjoining 
such acts or attempts constituting a breach (in addition to other legal remedies, all of which are non-exclusive). Upon such termina-
tion by Licensor, Licensee agrees to return to Licensor the Program and all copies and extracts thereof.
5. Limited Warranty. Licensor warrants solely to the original purchaser, for their benefi t alone, that for a period of ninety (90) 
days from the date Licensee obtained the Program:
(a) The Program components, including the Software and accompanying documentation, are free from defects in material or 
workmanship.
(b) The Program is properly recorded upon the Program Diskettes, tape or other media.
Additionally, Licensor warrants solely to the original purchaser, for their benefi t alone, that for a period of ninety (90) days from the 
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date Licensee obtained the Program:
(a) The documentation is substantially complete and contains all the information that Licensor deems necessary to use the 
Software.
(b) The Program functions substantially as described in the documentation.
The exclusive remedy for breach of this Limited Warranty is replacement of defective product. This Limited Warranty is extended 
only to the fi rst purchaser of the Software. To replace a defective disk during the warranty term, send the defective disk and proof of 
purchase to: PPR Direct, Inc., 74 20th Street, Brooklyn, N.Y. 11232.
DISCLAIMER OF WARRANTIES:  THE WARRANTY STATED ABOVE IS THE ONLY WARRANTY APPLICABLE TO THIS PROD-
UCT. ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ALL IMPLIED WARRANTIES 
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), ARE HEREBY DISCLAIMED. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY PPR DIRECT, INC., ITS AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR 
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY OR THE OBLIGATION OF PPR DIRECT, INC. WITH RESPECT TO 
THE PROGRAM.
THIS DISCLAIMER OF WARRANTIES AND LIMITED WARRANTY ARE GOVERNED BY THE LAWS OF THE STATE OF NEW 
YORK.
6. Limitation of Liability. Licensor’s cumulative liability to Licensee or any other party for any loss or damage resulting from 
any claims, demands or actions arising out of or relating to this Agreement, or in connection with the delivery, use or performance 
of the Program, shall not exceed the license fee paid to Licensor for the use of the Program. UNDER NO CIRCUMSTANCES 
SHALL LICENSOR BE LIABLE FOR ANY SPECIAL, EXEMPLARY, INCIDENTAL, OR CONSEQUENTIAL DAMAGES BASED 
UPON BREACH OR WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY, OR ANY OTHER LEGAL 
THEORY, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SUCH DAMAGES INCLUDE, 
WITHOUT LIMITATION, LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF USE OF HARDWARE OR ANY ASSOCIATED 
EQUIPMENT, COST OF CAPITAL, COST OF SUBSTITUTE OR REPLACEMENT EQUIPMENT, FACILITIES OR SERVICES, 
DOWN TIME, PURCHASER’S TIME, THE CLAIMS OF THIRD PARTIES, INCLUDING CUSTOMERS, AND INJURY TO PROPERTY.  
LICENSOR SPECIFICALLY DISCLAIMS ANY OBLIGATION TO INDEMNIFY LICENSEE FOR ANY ALLEGATIONS OR FINDINGS 
OF PATENT INFRINGEMENT BASED ON THE USE OR SALE OF THIS PROGRAM.
7. Trademark. PPR Direct, Inc. is a trademark of Licensor. No right, license, or interest to such trademark is granted hereun-
der, and Licensee agrees that no such right, license or interest shall be asserted by Licensee with respect to such trademark.
8. Governing Law. This Agreement shall be construed and governed in accordance with the laws of the State of New York.
9. Severability. Should any term of this Agreement be declared void or unenforceable by any court of competent jurisdiction, 
such declaration shall have no effect on the remaining terms hereof.
10. No Waiver. The failure of either party to enforce any rights granted hereunder or to take action against the other party in 
the event of any breach hereunder unless in writing, and in any event shall not be deemed a waiver by that party as to subsequent 
enforcement of rights or subsequent actions in the event of future breaches.
11. Export Controls. None of the Software or any underlying information or technology may be downloaded, used, or other-
wise exported or re-exported except in compliance with all United States and other applicable laws and regulations. In particular, but 
without limitation, none of the Software or underlying information or technology may be downloaded, used or otherwise exported or 
re-exported (i) into (or to a national or resident of) Cuba, Haiti, Iraq, Libya, Yugoslavia, North Korea, Iran, Syria or any other country 
to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury Department’s list of Specially Designated Nationals 
or the U.S. Commerce Department’s Table of Deny Orders. By downloading or using the Software, you are agreeing to the forego-
ing and you are representing and warranting that you are not located in, under the control of, or a national or resident of any such 
country or on any such list.
12. U.S. Government Restricted Rights. The Software and accompanying material are provided with RESTRICTED RIGHTS. 
Use, duplication, or disclosure by the Government is subject to subparagraphs (a) through (d) of the Commercial Computer Software 
- Restricted Rights clause at FAR 52.227-19 and its successors and counterparts, or in subparagraph (c) of the Rights in Technical 
Data and Computer Software clause at DFARS 252.227-7013 and its successors and counterparts, and to similar clauses in the 
NASA DFAR supplement or other revisions to the FAR sections, as applicable. Contractor/Manufacturer is PPR Direct, Inc. 74 20th 
St., Brooklyn, NY 11232.
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P
Preface
 
The iCommunicator software program provides the functions that lets you manage a full 
range of multimedia types, including full-motion video with CD-quality sound with a high-
end laptop or desktop personal computer.
 
This guide gives you all the information you need to know—how to begin using the pro-
gram, how to train your computer to recognize voice and speech patterns, and how to 
create and control text, sounds, and sign language videos.

Customer Support

Thank you for purchasing this product. PPR Direct is dedicated to ensuring that you gain 
the greatest possible value from our products. Please take a minute to learn about the 
support and services we offer. Note that the benefi ts and services offered by the manu-
facturer and its resellers are subject to change without notice.
 
Training 
 
The iCommunicator Training Manual provides a systematic training process for end us-
ers, speakers, and implementation managers. Onsite training may be purchased through 
authorized iCommunicator resellers

ii
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Customer Service

Customer Service is available to answer your questions about product availability, up-
grades, features, customer registration, policies, procedures, and other non-technical 
topics. 
 
The following services are available to registered iCommunicator customers:
 
Telephone Service
 
You can call Customer Service from 8:00 AM to 5:00 PM, Monday through Friday   
(Eastern Time). The number is 718-965-8600. 
 
Registration Status
 
Customer Service can answer questions about your registration status. Please have 
your product serial number ready when you call 718-965-8600.
 
Change of Address
 
Customer Service handles customer address changes. Send a letter that includes both 
your old and new address to:
 
iCommunicator
74 20th Street 
Brooklyn, NY 11232
ATTN: CHANGE OF ADDRESS 

iii
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Defective or Damaged Products
 
Contact Customer Service if your product is damaged or defective. Be sure to have your 
product serial number ready when you call. Defective equipment will be warranted per 
the equipment manufacturer’s warranty statement. After the warranty period, one year 
from purchase, replacement parts are available to registered users at a nominal charge.
 
Send the defective part, a brief explanation, and payment (if necessary) to:
 
Customer Service
iCommunicator
74 20th Street 
Brooklyn, NY 11232
 
 
Product Upgrades and Updates
 
For warranty, upgrades, registration, change of address, and technical questions, call 
Customer Service at 718-965-8600.

iv
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Introduction
Welcome to the iCommunicator, Version 4.0, software program. The iCommunicator pro-
gram helps persons who are deaf, hard-of-hearing, or those with other communication 
challenges achieve two-way communication. It is an interactive solution to communica-
tion accessibility needs in educational, workplace, and public access venues. The iCom-
municator is also a teaching tool that helps improve literacy skills.
 
The iCommunicator software program converts speech into multiple streams of data 
for simultaneous presentation of text, video-sign language, and computer-generated 
speech. The iCommunicator software works with Dragon Naturally-Speaking speech 
recognition software allowing you to train your computer to recognize voice and speech 
patterns. The program stores these voice fi les for immediate access. 

The iCommunicator Software Program 

The iCommunicator software program converts human speech to digitally-imaged sign 
language, computer-generated speech, and text printed on the computer screen. Like-
wise, it lets you type words and phrases that the program converts to computer-generat-
ed speech and then relays to audio speakers or peripheral hearing devices. For persons 
with hearing loss, the iCommunicator program generates speech and sends it to co-
chlear implants, FM systems, and hearing aids. It provides a clear audio stream, devoid 
of extraneous background noises. 
 
The iCommunicator program lets you choose how you want to deliver your information. 
You can choose to activate sign language (with or without audio) and fi ngerspelling of 
words. It lets you control the speed of the information and the way the computer pres-
ents that information. You can also store up to 24 preprogrammed messages and deliver 
them simply by pressing assigned function keys. For more information on effective strat-
egies for using the iCommunicator software program, consult the professional training 
manual. 

1 – 1
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Minimum Hardware Specifi cations

The iCommunicator software and peripheral kit includes: 

•   iCommunicator Software Setup CD’s
•   Dragon NaturallySpeaking Setup CD’s
•   LightSPEED LES-360 FM System (or equivalent)

o Wireless receiver
o Wireless transmitter
o Battery charger and cables
o 2 NiMH rechargeable batteries
o Noise canceling microphone
o Microphone set-up guide

•   Visikey Wireless Keyboard
•   PS2 to USB adapter
•   iCommunicator Hardware Security Key
•   Audio Cables (2)
•   iCommunicator Installation Guide
•   iCommunicator Training Manual
•   iCommunicator User Guide
•   Registration Card 

The iCommunicator software application requires the following minimum laptop or desk-
top computer hardware and software:

•   Operating System:  Microsoft Windows XP or  2000
•   Processor:   Pentium III, 800MHz
•   Memory:    512 MB RAM (1GB recommended)
•   Hard Drive:   2GB available space on Drive C
•   USB or Parallel Port: To attach hardware security key
•   Video:   8MB
•   Display Resolution: 800x600; high quality
•   Sound/Speakers:  SoundBlaster Pro Compatible
•   CD-ROM:   24X (or DVD-ROM)

1 – 2
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2 

Getting Started

Before you turn on your computer, connect all the hardware and verify that all the cables 
are properly secured. Refer to the iCommunicator Installation Guide included with your 
software and peripheral kit.

•   Connect the LightSPEED receiver (professional kit) or the direct-connect microphone 
(standard kit) to the microphone input jack on the PC.

•   Connect the audio Y-cable to the audio output jack (headphone) if the end-user will be 
using this feature.

•   Connect the AC power cord to your PC.

•   If your computer is a desktop PC, connect the keyboard, mouse, and monitor before 
you turn it on.

•   Power on the unit.

•   Verify that the batteries for the LightSPEED FM transmitter and receiver are fully 
charged. Fully charged batteries last for approximately fi ve hours of normal use. We 
recommend that you change the transmitter batteries when the battery indicator light 
on the top of the unit shows a low (red LED) condition.

•   Install the software using the Installation Guide provided with your software kit. You 
will be performing either a new installation or an upgrade as described below.

– New Installation. If you do not have a previous version installed on your computer, 
you will be completing a new installation. After installation, you will be directed to 
immediately Create a New User, that is, build a speech/voice recognition fi le. This 
is necessary so that you will be able to speak to your computer and have it recog-
nize your speech and voice characteristics. Refer to Modules 3 and 4 in the Train-
ing Manual for directions.

– Upgrade Installation. If you currently have the iCommunicator software V.3.X.0 
installed, follow the iCommunicator V.4.0 Upgrade Procedure shipped with your 
software kit.

2 – 1
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3 

Using Your iCommunicator 
Software Program 
Start the iCommunicator program from the Windows Start button, or double-click the 
icon on your desktop. The program is ready when the microphone is on. 
 

Note: We recommend that you close all other applications while using 
iCommunicator. Opening additional windows can slow your iCommunicator 
program.

  
To begin using the iCommunicator program and peripheral kit after you properly install 
the software, you must fi rst select the speech/voice recognition fi les you want to use. 
These are the fi les created in the New User Wizard. (Refer to Chapter 4, Voice Recogni-
tion). The speech/voice recognition fi les contain all the information that Dragon Natural-
lySpeaking gathers about the speaker. 
 

Parts of the iCommunicator Program Main Screen 

The following describes the elements of the iCommunicator window that are your tools 
for effective communication. You’ll learn more about how to use window elements 
throughout this manual. The following illustration shows the various elements of the 
iCommunicator screens and includes a brief explanation of each element.

3 – 1
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Control Window:
Use the menu options 
to control the iCom-
municator program. 

You can also send 
messages and note 
text from this window.

Text Window:
Text converted from 
speech appears in this 
window.

Your iCommunicator program contains three windows joined together in one display. If 
you choose, you can separate the windows and control its size and display in the Cus-
tom Viewing mode. Your iCommunicator program remembers your window settings until 
you change them. 

The iCommunicator Windows

•   Control Window - This window controls the iCommunicator program’s speech rec-
ognition. You can change the speech recognition options, enter text for conversion to 
speech, enter text as a note, and manage your microphone.

•   Signing Window - This window displays sign language and fi ngerspelling videos. 

•   Text Window - This window displays text converted from speech or text fi les. You 
can add your own notes to this window and save it in .RTF format. You can then later 
review the contents using iCommunicator, or edit the contents using a standard word 
processor. Text from email, web pages, or other application using this iText tool.

Signing Window:
Speech and text are converted to sign 
language and fi ngerspelling in this 
window. You can change the speed of 
the signing.

3 – 2
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Using the Menus 

The standard view iCommunicator screen has pull-down menus on its menu bar. Menus 
include: File, Views, Options, Actions, Signing Options, Font, and Help. To view the 
selections available in these menus, click the name of the menu you want to view. Move 
the mouse pointer down to highlight the item you want, and then click the left mouse 
button to select it. 
When you choose the custom mode, the menus function the same, but will appear on a 
different window. For example, the Signing Options menu appears on the Signing Win-
dow.

File Menu

Use  To
 

New  Clear the text window and prepare a new fi le. When you select this option,  
  the iCommunicator program removes the text from the window, but does  
  not save it. If you want to save any text in this window, you must do so  
  prior to selecting New.
 
Open  Open an existing text fi le.

Save  Save the changes to an existing fi le. 

Save As Name and save the text displayed in the Text window as a fi le.
 
Exit  Close the iCommunicator program and return to your desktop. You can  
  also click on the X in the upper right corner of the Control window to exit  
  the iCommunicator program.

Views Menu

Use
To

Themes
Change the border display and color themes for the 
iCommunicator program windows.

Standard Mode is
selected

Control the window display.  A check mark indicates the 
iCommunicator is operating in the standard (three windows 
joined) mode.  Deselect this menu option to separate and control 
the three windows independently.

3 – 3
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Options Menu

Use To

Microphone On Toggle microphone on or off.

Autosave every (n)
minutes

Select automatic save options or restore the last auto save.  
The iCommunicator program saves the text window every 
5 to 60 minutes.

Speak 
Incoming Words

Convert recognized words to audible, computer-generated 
speech and transmit it to the hearing assistive device.

Set Talking
Voice

Change the tone, pitch and speed of the computer-generated 
voice.  Choose between male or female voices.

Edit Quick
Say Keys

Edit the Quick Say phrases assigned to function keys.  
The iCommunicator program stores up to twenty-four 
quick say messages.

Clear Text Window
when starting

Display an empty text window each time you turn 
on the program.

Start With Window
When you select this option, the iCommunicator will open 
immediately when you start your computer.

Speech 
Recognition

Change the current speaker, add a new user, save speech 
fi les, run General Training for voice recognition, run Audio
 Wizard, delete a speaker, run Vocabulary Builder, 
or Show Results box.

iText
iText displays text from documents, email, web pages, and 
other applications in your computer’s iCommunicator text 
window, and then signs and/or speaks the text.

3 – 4
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Actions Menu

Use To

Reset
Halt the computer-generated speech, turn off signing, and 
reset the microphone.

Pause

Show

Temporarily halts the text window, signing, and 
computer-generated speech.  Select Pause again to restart.

Displays sign for a word selected with the cursor.

Sign Text Window Sign the words in the text window without generating a voice.

Speak Text Window
Convert the words in the text window to audible 
computer-generated speech and send it to the hearing 
assistive device (without the Signing option).

Sign and Speak 
Text Window

Sign words in text window and generate audible 
computer-generated voice at the same time.

You can choose where an action starts.  Place your cursor in the text box and click 
where you want the action to begin before you select the Actions menu command.

*  Tip:  The Action menu commands Reset and Pause also appear on the top border of 
the Text window.  Simply click to use the Action command.  When you click pause, the 
Text Window’s display changes to “Continue.”  Click Continue to restart the action.

3 – 5



The iCommunicator 
User Guide

Signing Options Menu

Use To

Word List
Display a list of words in the signing video library.  Choose 
a word from the drop-down list, and then click the check 
mark to view the associated signing video.

Enable Signing Start or stop the signing videos.

Fastest Set the signing speed at the fastest level.

7,6,5,4,3,2
Control the speed of signing.  The higher the number you 
choose, the faster the signing.

Slowest Set the signing speed at the slowest level.

Font Menu

The font menu lets you choose the font size for text in the text window.  The default size 
id 16 points; however, you can choose from several options.

Help Menu

Use To

Contents Display a list of help topics, view an index, or search the help 
system for a topic.

Hot Keys Display a list of hot keys and their function.

About Display license information about the iCommunicator program.

3 – 6
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Hot Keys and Shortcuts

You can quickly execute iCommunicator menu commands using keyboard combinations.  
The key combination displays on the menu along with the command.  To display a list of 
all hot keys, select Hot Keys from the Help menu.  Hold the fi rst key down (Ctrl or Alt), 
then touch the key shown with it to use the shortcut.

Hot Key
Combination

Menu
iCommunicator
Menu Command

Ctrl+A File Save As

Ctrl+B Actions Sign and Speak Text Window

Ctrl+D View Return to Defaults

Ctrl+E View Enable Signing Window

Ctrl+G Actions Sign Text Window

Ctrl+H Help Displays list of Hot Keys

Ctrl+I Options Speak Incoming Words

Ctrl+K Actions Speak Text Window

Ctrl+N File New

Ctrl+O File Open

Crtl+M Options Toggles microphone on/off

Ctrl+P Actions Pause

Ctrl+R Actions Reset

Ctrl+S File Save

Ctrl+W
Signing 
Option

Word List

Ctrl+Enter N/A Notes Say This box

3 – 7
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Menu Options:
Select menu options to control
iCommunicator.

Say This-Note This:
Type your responses in this box.
Click the down arrow to view 
previous messages.

Current Speaker:
Click here to
select speech
voice recognition
fi les.

Microphone
ON/OFF Button:
Click here to turn
microphone ON and 
OFF.

Microphone Status
Bar:
Click here to toggle
the microphone ON
and OFF.

The Control Window

The Control window lets you manage speech options.  Use the Control window to:
 
 • change the speaker you want your computer to recognize
 • manage the microphone
 • enter text you want spoken
 • add notes to the text window

3 – 8
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Joining and Separating the Windows

The iCommunicator contains three windows joined together.  You can customize your 
program by turning off the standard mode.  You can then control and move each of the 
three window elements independently.

To separate and move a window:

1. From the Views menu, deselect Standard Mode is selected.

 The windows separate.

2. Click and hold down the left mouse button and drag the window to the
 desired location.

3. Release the mouse button.

To move all windows at the same time:

1. Position your pointing device on a window border.

2. Hold down the right mouse button and drag to the desired location.

To return to standard mode:

• From the Control Window Views menu, select Change to Standard Mode.

Minimizing and restoring the iCommunicator Windows

The standard Microsoft Windows buttons located in the upper-right corner of the 
iCommunicator title bar provide a quick and easy way to minimize, maximize, restore, 
and exit the iCommunicator program.  When you choose the custom (windows separate) 
mode, icons appear in the upper-right corner of each window.

Use To

Reduce (minimize) the iCommunicator program to a button on the 
task bar.  Click the taskbar button to open iCommunicator again

Decrease the Control Window Size.

Increase the Control Window Size.

Exit the iCommunicator program and return to your desktop.
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The Microphone Status Bar

 The microphone status bar show how your microphone is working.
 Color appears over the background to indicate the current status.

 Color  Status

 yellow  on and ready to receive speech

 green  in use and receiving

 red  audio level too high

 black  microphone off

 * Note: Run the Audio Wizard option if you see red on the microphone
 status bar.  (Refer to Chapter 4, Audio Wizard)

 Use the microphone status bar to turn the microphone off and on.  Move the
 mouse pointer directly over the microphone status bar and click it once to turn
 the microphone OFF.  Click again to turn ON.  The default is ON.

Microphone ON/OFF Button

 Click the ON/OFF buttons to manage the microphone.
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The Speaking Status Bar
 The speaking status bar shows your program is processing the words you type
 in the Say This/Note This text box.  Color fl ashes over the background to indicate
 computer-generated voice is transmitting.  When transmission is complete, 
 the speaking status bar disappears.

Speaking Status Bar:
Appears when processing 
Say This/Note This text box.

The Say This/Note This Text Box

 The iCommunicator program enables the computer to speak for you.
 Type what you want to say and press Enter.  The iCommunicator program
 converts the text to computer-generated speech and sends it to speakers
 and to hearing assistive devices.

 You can also use the Say This/Note This text box to add your own notes
 to the text window.  Press the Control/Enter to include your note.  Notice
 that iCommunicator encloses your notes with arrows.  The Note This
 function does not generate voice.
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Click in the check box to view 
the second set of Quick Say 
buttons.  Press Shift and the 
function key to speak the 
additional messages.

You can enter twelve Quick Say 
messages in this screen.  
Press a function key to tell 
iCommunicator to say that mes-
sage.

Note:  When you press a function 
key, iCommunicator fi rst displays 
the message in the Say This, Note 
This text box.  You can add more 
text, if you choose.  Press Enter to 
say the message.

To Create a quick message:

1. From the Options menu, select Edit Quick Says Key.

 The Edit Quick Say Keys box appears, listing function keys F1 through F12
 along with an associated text box.

2. Choose a function key and type your message in the text box beside it.

 The text line is not limited to the line size or window area, so you can continue
 typing up to 256 characters.  Repeat step 2 for each function key you use.

3.  Click Save to  store your Quick Say messages.

4. Choose Exit to return to your iCommunicator window.

* Tip:  If you want to assign twelve more messages, check the “Show Shift” box and 
continue entering messages.

Quick Say Function Keys
 You can preprogram up to twenty-four Quick Say messages and initiate audible,
 computer-generated speech by pressing the function key assigned to 
 your message.  The iCommunicator program converts the text to a 
 computer-generated voice and relays it to speakers and hearing
 assistive devices.
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Delivering Quick Say Messages

 To deliver a quick say message:
 
 1. Press the function key you assigned for the message.
  
  Your preprogrammed message appears in the 
            Say This /Note This text box.

 2.  Press Enter.

  The iCommunicator program sends the message to the speakers and 
  hearing assistive device.

  * Tip: Deliver the fi rst twelve Quick Say messages by pressing the 
  appropriate function key assigned to your message.  Deliver the second
  twelve Quick Say messages by pressing the shift key and the appropriate

Reviewing Quick Say Messages

 You can review your last ten Quick Say messages.  Click the list button in the
 Say This/Note This box to view your messages. 
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Set the Talking Voice

 You can select the voice, pitch and speed for iCommunicator’s voice.
 
  To set iCommunicator’s talking voice.

 1. Select Set Talking Voice from the Options menu

Click on the down arrow to see a list of talking voice 
options.  Click and highlight the one you desire.

Click and drag 
the sliders to set 
the desired pitch 
and speed of the 
talking voice.

Press the Test 
button to listen 
to the selected 
voice.

When you’ve fi nished setting the talking voice to levels 
that suit you, click the Accept Changes button to save 
your settings;  otherwise, click the Discard Changes but-
ton and begin again.

 2. Click the Talking Voice list button and select a voice.

 3. Press the Test button to test the voice.

 4. Move the sliders to set the pitch and speed.

 5. Choose Accept Changes to save your selection, or choose Discard
  Changes to begin again. 
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iText Tool
 Use the iText tool to have documents, email and web pages signed and/or 
 spoken through the iCommunicator program.  iText captures text from web 
 pages, emails, word processing documents, and other software applications 
 and immediately displays it in the iCommunicator Text window in the Standard
 viewing mode.

 Follow these directions to use iText.

1.  Open the iCommunicator program.
 a.  The iText button will display in your computer’s Systray.
 b.  From the Options menu, selected iText_Default Left Click Action.  
      Click on the desired action.

 c.  From the Options menu, select iText_Pause Before Action.  Select the 
      delay time before the action starts in the Text window.
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2. Select and open a document in another application, such as Word, Excel,
 PowerPoint, an email message, or a web page.  Place the cursor in that text.

3. To capture all of the text in the document:
 a.  Click on the iText button in the Systray.
 b.  Text will display in the iCommunicator Text window and the chosen
      action will begin.

4. To capture selected text in the document:
 a.  Highlight the text you wish to have signed and/or spoken.
 b.  Right click on the iText button in the Systray.  A pop up menu displays

 c.  Left click on the desired action for the selected text (i.e., sign, speak,
      sign and speak).
 d.  Selected text will appear in the iCommunicator Text window.  Text will
      be signed and/or spoken according to the action from the pop-up menu.

Loading a Speaker’s Speech Files
 To recognize incoming speech, you must tell the iCommunicator program which
 speech fi les to use.  Refer to Chapter 4 for more information about speech fi les.

 To load speech fi les:

1. Click the current speaker’s name at the bottom of the Control Window to 
 display a list of speakers.
 or
 From the Options menu, select Speech Recognition Change Current 
 Speaker.

2. Select a speaker name from that list.

 You will see the message, “Change active speech fi les.  Please wait.”

When the iCommunicator program is ready to receive, the new speaker’s name appears 
at the bottom of the Control Window.
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The Signing Window
 The signing window displays sign language and fi ngerspelling videos.

 To turn on the signing options:

 •  From the Options menu, choose Enable Signing.

 A check mark appears on the menu.

 To turn signing off:

 • Click Enable Signing again.

 The check mark disappears; indicating the signing option is disabled.
 
 To control the speed of signing

 • Select Options and choose a signing speed.  The higher the number
  you choose, the faster the signing.
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Locking and Unlocking the Signing Window

 You can choose to turn off and lock the signing feature.  When you choose the
 Signing Locked option, all commands for the signing option disappear from the
 iCommunicator menus.  A check mark appears on the Options menu to indicate
 signing is locked.  A user cannot unlock and use the signing feature unless they
 enter the correct password.

 To lock or unlock the signing window.

 1. From the Control Window Options menu, choose Signing Locked.

  The password window appears.

 2. Enter a password in the Password window text box.

  * Note :  defaultpassword is the password when the iCommunicator
  program ships from the factory.  You must type defaultpassword in the text 
  box before attempting to lock signing or change the password.

 3. Choose the Enter button to enter a password, the Change button to 
  change your password, or the cancel button to close the password
  window without changes.  Follow the instructions on your screen.

  * Important:   Remember the password you enter.  You will need it to
  unlock the signing feature.
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The Text Window

 As iCommunicator recognizes speech, it converts it to text and displays it in the 
 Text window.  You can also enter text from the keyboard.  For example, you may 
 want to insert notes during a classroom lecture, or simply display your two-way
 conversations.

Use the Font 
menu to change 
font size.

 To add your own notes to the text window.

 1. Click in the Say This/Note This text box.

 2. Type your text.

 3. Press the Control and Enter key.

  Your notes appear in the text window enclosed by arrows.

Changing the Text Window Font Size

 You can change the look of the text by changing the font size.

 To change the font size in the Text Window.

 1. From the Font menu, select the size you want, and then click OK.
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Saving the Contents of the Text Window

 The iCommunicator program lets you save the information it displays in the text  
 window.  Once saved, you can edit it using a word processor, such as a Notepad
 or Microsoft Word.

 To save the contents of the text window.

 1. From the File menu, select Save As.

  The Save As dialog box appears.

 Select Directories and drives from the Directories list, if you want to
 save a copy in a different directory or drive.

 2. In the File name text box, enter the name of the fi le.

 3. Choose Save.
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Clearing the Text Window

 You can clear the contents of the Text window.

 To clear the text window.

 1. Select New from the File menu.

  The program will prompt you to confi rm your action.

 2. If you are sure you want to clear the text window, choose Yes.

 To clear the contents of the text window each time you turn the program on.

 • Select Clear Text Window when starting from the Options menu.

Changing the Windows Theme

 You can choose from several preprogrammed themes to change the look and 
 color of the iCommunicator windows.

 To Change your window theme:

 1. From the Views menu, select Themes.

 2. Choose a theme name.

Retrieving a Sign for a Word

 There are two ways to retrieve a sign for a word displayed in the text window.
 Place the cursor on a word, such as numerous.  If the sign is not in the video sign 
 language dictionary, the program fi ngerspells the word.

 Do one of the following:

 • Double click on the word with the left mouse.

 • Click the Show button on the Text window border.  The sign for the
  word displays in the Signing window.

 Another option for displaying the sign for a word is to select Word List from the
 Signing Options Menu.  An alphabetical list of words in the signing video library
 appears in the dropdown list.  Choose a word and then click the check marks
 to view the accompanying signing video.
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Using the Electronic Dictionary

 You can obtain the defi nition for a word displayed in the text window by placing
 the cursor on the word.  Then press Shift + Right click to reveal the defi nition.
 The electronic dictionary will also pronounce the word when you click on the 
 “Say” icon.
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4
Speech Recognition
Before the iCommunicator program can have two-way communication, each speaker 
must train the program to recognize his or her voice and speech patterns,  Once trained, 
the iCommunicator program can then match the speaker’s specifi c sound patterns to 
words.  The following lists important tips for successful speech and voice recognition 
training.

 •  Consistent microphone positioning is important to maintain a high level of 
    translation accuracy.  Squeeze the foam widescreen over the microphone to 
    help identify the surface of the microphone.
     °  The LightSPEED boom microphone should be positioned along the left jaw
         line, about an inch from the left corner of the mouth.  For maximum 
         performance, the rounded portion of the LightSPEED microphone element
         should be positioned in front of the chin and not directly in front of the 
         mouth.  The fl at side of the microphone is then directed away from the face.
     
      °  The Parrott Bermuda microphone should be positioned along the jaw line.
          The fl at part of the Parrott microphone should be worn so it is located one 
           fi nger-width from the corner of the mouth.

 •  Check the LightSPEED battery indicator light on both the receiver and 
     transmitter frequently.  Red indicates the unit is on and has battery power.
     The LED does not illuminate when the battery power is exhausted.

 •  Speak clearly and continuously.  Maintain your normal vocal effort and volume,
     and speak all words completely.

 •  Correct recognition mistakes and add words to the vocabulary.

 •  Speak to your computer to increase recognition accuracy.
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Creating and Managing Users

 To train the iCommunicator program, begin by using the New User Wizard.
 After the software has been installed, it is necessary to Create a New Speaker
 in order to use the software program.  The New User Wizard prompts you to 
 create new user voice fi les.  It usually takes about ten to fi fteen minutes to 
 complete the New User Wizard.  Begin reading aloud while Dragon 
 NaturallySpeaking tests your voice for pronunciation, volume, and speed.

 The New User Wizard window has elements that work the same as the elements
 in other Windows applications.  If you are not familiar with basic Windows
 elements, we suggest you refer to your Windows User Guides for a complete 
 explanation of Windows elements

 To create a new user:

 1.  From the Control window Options menu, choose Speech Recognition
      and Create New Speaker.
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The New User Wizard window appears.

2. Read the screen information, and then click OK.

Type the desired 
name in the 
Your name fi eld, 
and then click the 
Advanced button.

In the Advanced window, ensure 
that the Speech Model is 
BestMatch III.  If not click the 
dropdown menu and select it.

Verify that the Vocabulary Size
option is set to Large.  If not, select 
it from the dropdown menu, and 
then click OK.
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The New User Wizard’s Create User window reappears.

 3.  On the Create User window, enter a unique name for the user.

 4.  Choose a Language type (US English most common) and Dictation 
      source (Microphone plugged into Mic-in Jack most common).

 5.  Select the Advanced button to choose a speech model and vocabulary
      size.

      You must select the BestMach III Model as the speech model, and
      Large as the Vocabulary size.
 
 6.  Choose OK to accept your changes.

 7.  Click Next.

       Read and follow the instructions for connecting your microphone,
       choosing your input device, and positioning your microphone.

       Continue to Calibrate your microphone’s volume.
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Calibrating your Microphone’s Volume

 Calibrating your microphone’s volume is important to achieve successful
 voice recognition.

 To adjust the microphone volume.

 1. Click the Start Volume Check button.

Click the Start 
Volume Check 
button and follow 
the instructions as 
they appear in your 
window.

Your computer will 
adjust the volume 
setting for your 
voice.  Be sure to 
speak clearly and in 
your normal voice.

When the computer 
beeps, the process 
is done.

 2.  Begin reading aloud.

 3.  When the volume level is set, click Next to continue.

 When the volume adjusts successfully, the message “Finished” appears in 
 the Volume status area of the adjustment screen.
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Checking Audio Quality

 To check your audio quality:

 1.  Click the Start Quality Check button.

Click the Start 
Quality Check but-
ton and follow the 
instruction in your 
window.

Your computer will 
check the audio 
quality of your 
microphone.  Be 
sure to speak 
clearly and in a 
normal voice.

When the computer 
beeps, the process 
is done.

 2.  Read the paragraph in the middle of the screen.

 When the quality check completes, a message displays along with the 
 signal-to-noise ratio value.  A minimum value of 22 is required.  A value in
 the mid twenties to low thirties range is common.  A lower value will degrade
 speech recognition performance.

 3.  Click The Next button.

 Continue with general voice training.

 *  Note:  You must complete the General Training to create a new speaker.
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General Voice Training
 To begin general voice training:

 1.  Click the Go button at the bottom of the New User Wizard Train Dragon
      NaturallySpeaking screen.

 2.  Read the text aloud as it appears in the window.

 When you complete the required reading, the Select Text screen appears.

 3.  Select a story from the list box, and click OK.

 Each Story takes approximately ten minutes to read.  As Dragon validates your
 reading, a yellow arrow progresses.

 4.  Click the Go button and begin reading aloud.

 After completing the General Training portion, the program should know your
 voice well enough to accurately recognize what you say.  However, reading
 additional stories may increase accuracy.  We also recommend that you run
 Vocabulary Builder to increase recognition accuracy.
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Vocabulary Builder

 Vocabulary Builder analyzes documents that already exist on your computer,
 such as textbook glossaries and chapter summaries, technical documents,
 manuscripts, class rosters, and vocabulary lists.  It gathers information about 
 your specifi c writing style and identifi es any new words so you can add them 
 to the vocabulary.
 
 To start Vocabulary Builder:
 
 1.  From the Options menu, select Speech Recognition, Vocabulary Builder,
      Vocabulary Builder.

A warning screen appears.

 2.  Choose Yes to continue to Vocabulary Builder, or No to cancel the 
      procedure.

The Vocabulary Builder Welcome screen appears.

 3.  Read the information screen and click Next.

 4.  (Optional) type the fi le path to the fi le containing a list of 
      words you want.
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 to add, or click Browse to fi nd the fi le.

 *  Note:  When you add words this way, you will not have the opportunity
 to automatically train unfamiliar words.  Use Analyze documents to both 
 add words and train.   (See next step).

 *  Note:  The word list must be in .TXT format.

 5.  If you specify a fi le, click Add Words from List and click Next.

      To skip this step, click Next.

 To analyze documents:

 1.  Click Add to select a document to analyze, and click Open.  You can 
      select multiple documents by holding down the Control key while 
      you select.

      Your selections are added to the document list.
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 2.  To begin analyzing your documents, click Analyze Documents.

As document analysis completes, the Analyzed column displays the word “Yes”.

 3.  When the program is fi nished processing all your documents, click Next.
      

      Vocabulary Builder displays a list of new words found on the Add New Words 
      dialog box.  You can add these words to the vocabulary to improve accuracy.
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 To add new words:

 1.  Click the words you want to add to the vocabulary, then choose Add
      Checked Words to Vocabulary.

      The message “Do you want to train the newly added words now?”
      appears.

 2.  Choose Yes, then click record to voice train the new words.

 3.  Click Done, when you complete the new word training.

 4.  Click Next to continue.

 The Adapt to Document Style screen opens.

 5.  Select Yes to both options on the Document Style screen and click Next.

 6.  Review the summary information and click Finish to save your changes.
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Adding Additional Users

 When a new speaker wants to use the iCommunicator program, that person
 needs to create his or her own speaker fi les.  Always remember to switch to the
 appropriate speaker before using the iCommunicator program;  otherwise,
 the program may fail to interpret voice accurately.

 To add new users, follow the steps described earlier for the New User Wizard.

Opening Speech Files
 When a new speaker begins talking, you must open that speaker’s voice fi le.

 To open a speech fi le:

 1.  Click the current speaker name at the bottom of the Control window.

      A list appears showing the names of all users.

 2.  Select a user name, or from the Options Menu select Speech 
      Recognition, Change Current Speaker, Speaker’s speech/voice fi le name.

 You see the message, “Changing active speech fi les, please wait.”

 When the program is ready to receive the new voice, the speaker’s name
 appears at the bottom of the Control window.

Deleting a Speaker

 If you are certain that you no longer need a speaker fi le, you can delete it.
 Once you delete a speaker fi le, it is gone forever.  Make sure you don’t need
 it before you remove it.  Always use the Delete Speaker menu selection to
 delete speaker fi les.  Delete Speaker is the only way to properly remove all 
 information about a user.

 To delete a user

 1.  At the Control window Options menu, select Recondition
      and Delete Speaker.

 2.  From Speaker list box, select the name you want to remove, then click
      Delete and answer yes to the prompt.

 3.  The Done window appears.  Click OK.

 *  Tip:  If you want to delete the open user, you must close it fi rst by
 selecting and opening a different user.
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Run General Training Again

 If you follow the instructions in this chapter and still have some speech and
 voice recognition errors, the iCommunicator software program may need 
 additional training.  Spend additional time training the program, and you will see
 an improvement in its translation accuracy.  Complete an accuracy check found 
 in the Training Manual.  You may run General Training again and engage in
 more vocabulary building.

 To run General Training again:
 
 1. From the Control window Options Menu, select Speech Recognition and
    Run General Training.

A warning screen appears.

 2.  Choose Yes to continue with General Training, or No to cancel the
      procedure.

 3.  Select a story.

 4.  Click the Train Now button to continue.

 5.  Click the Go button when you are ready to begin training.

 6.  Follow the screen instruction.

      The more you read, the more the speech recognition software learns
      about your sound patterns.  The General Training session typically takes
      approximately thirty minutes.

 7.  When you are fi nished reading, click Finish.

 For more detailed instructions, refer to General Voice Training described
 earlier in this chapter.
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Run Audio Wizard

 The Audio Wizard sets your microphone and sound system for optional speech
 recognition.  If your microphone status bar continually shows red, you may have
 an audio problem.  Run Audio Wizard to readjust your audio levels.

 You should rerun Audio Wizard any time there is a change in your voice or the
 acoustical environment, and when you change microphones.  If you voice train in
 a different environment from where the iCommunicator is routinely used, rerun   
           the Audio Wizard in the new environment.

 To run Audio Wizard:

 1. From the Control window Options menu, choose Speech Recognition,
     Run Audio Wizard.

A warning screen appears.

 2.  Choose Yes to continue to Audio Wizard, or No to cancel the procedure.
      
       When you choose yes, the Audio Wizard Welcome screen appears.

 3.  Follow the instructions on the screen.

 Refer to Calibrating your microphone and Checking Audio Quality for more
 detailed instructions.
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Using Vocabulary Editor
 
 If the program does not recognize a word or a phrase correctly, use Vocabulary
 Editor to train the program.  Vocabulary Editor lists all words in your active 
 vocabulary and lets you add, delete, and train the program to understand 
 you pronunciation.
 
 To run Vocabulary Editor:

 1.  From the Control window Options menu, choose Speech Recognition,
      Vocabulary Builder, and Vocabulary Editor.

A warning screen appears.

 2.  Choose Yes to continue with Vocabulary Editor or No to cancel the
      procedure.

 3.  Type or locate the word you want to train in the written form word list.

      If the word does not appear, add it to the active vocabulary before you
      train it.
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 4.  Select the word.

      *  Note:  To select more than one word, hold down the Ctrl key while
       you select.

 5.  Click the Train button.

 6.  Choose Record.

       The word or phrase appears in the written form column of the Train
        Words box.

 7.  Speak the word or phrase clearly.

 8.  Click Done.

Correcting Speech Recognition Errors

 When iCommunicator translates a word or phrase incorrectly, it is important that
 you correct its recognition mistake.  Correcting mistakes teaches the program
 not to make the same mistakes again and makes iCommunicator more accurate. 
 You can correct mistakes as soon as they happen or go back and 
 correct them later.

 When you see a mistake in your last word or phrase, you can stop and correct 
 it by saying, “correct that.”

 To correct your last word or phrase.

 1.  Repeat the word or phrase once so that it appears 
 (incorrectly translated) on a line by itself.

 2.  Say “Correct That”, and then wait until the Correction window appears.

 3.  If the correct word or phrase appears on the Correction window’s 
      choices, select it.

      OR

      Click on “Spell That.”  If the correct word or phrase appears as a choice,
      select it.  If the correct word or phrase does not appear, type it into the 
      text box.
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 4.  Place a check in the “Train how to pronounce this” box.  Then click OK.

                The Train Words window appears with both the correct and incorrect
       word.  Teach the program how each word sounds as you record them.

 5.  Choose “Go,” speak the fi rst word in  the text box, and then speak 
      second word.  

 6.  Click Done.

 7.  Save your speech fi les (Options       Speech Recognition       Save 
      Speech Files).

 To go back to correct a word or phrase:

 8.  Say “Correct (x)”, where (x) is the word or phrase you wish to correct.
 
 9.  Follow the steps above.

 *  Tip:  After you correct a word or phrase, use it in a sentence so the 
 program recognizes it in context.

 Refer to your Dragon NaturallySpeaking User’s Guide or Help Menu for
 more information.

The Show Results Box

 You can choose to turn on a small window that displays the result of the
 voice analysis as it occurs.  This feature will help you analyze recognition
 problems.

 To turn on the Show Results box:

 •  From the control window Options menu, select Voice Recognition, Show
    Results Box.

    A small window appears in the upper left corner of your desktop.  A check
    mark appears on the menu option.
 
 To turn off Show Results:

 •  Select Show Results Box again.

    The check mark disappears.  The option is disabled.
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Archiving and Restoring Speech/Voice Recognition Files

 There may be times when it is necessary to backup a speaker’s speech/voice
 (S/V) fi le:

 •  a speaker completes S/V recognition training on one computer and
    needs to transfer the S/V fi le to another computer.

 •  to remove a speaker’s S/V fi le from a computer and save it for future use.

 This fi le size limits storage to Zip Drives, Local Area Network (LAN), LS-120
 SuperDisk Drives, or CD-R (W) Drives.  Follow the procedures below to archive
 and restore a speaker’s S/V recognition fi le.  Review each procedure
 before initiating the process.

Location

 Each speaker who establishes a S/V fi le in the program has his or her own 
 named folder inside the Users folder.  S/V fi les for iCommunicator V.  3.1 are 
 located in C:\Program Files\Dragon\NaturalSpeaking\User\Speaker S/V
 fi le name.

Archive Procedure

 Use Windows Explorer to copy S/V fi les to the appropriate external device 
 destination, such as a Zip Drive, LAN, Superdisk Drive, or CD-R/W.

 1.  From the Windows Start button, select Programs } Accessories }
      Windows Explorer.

 2.  To back up all S/V fi les on the program, navigate to the User folder
      (My Computer, C: Drive, Program Files, Dragon, NaturallySpeaking, 
      Users, Speaker S/V fi les names).  Select the User folder, and then copy 
      it to the appropriate destination.

 3.  To backup a specifi c S/V fi le, navigate down one level and then select
      speaker’s S/V folder you wish to backup.  (From the left panel select My
      Computer.  Then select the following path:
      C:\ProgramFiles\Dragon\NaturallySpeaking\Users\  Speaker S/V 
      fi le name).
 
 4.  Copy the speaker’s S/V folder to the appropriate destination.
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Restoring Speaker S/V Files

 1.  To restore all speakers, copy the previously backed-up User folder
      to drive C:\Program Files\Dragon\NaturallySpeaking.

      *  Tip:  This process replaces all speaker fi les currently on the 
      iCommunicator program.  If S/V fi les on the program are valid, 
      use the backup procedure described above before initiating the 
      restore process.

 2.  To restore a specifi c S/V fi le, copy the speaker’s S/V backup fi le to drive
      C:\Program Files\Dragon\NaturallySpeaking\User\Speaker S/V fi le name.

 3.  Start iCommunicator.

 4.  From the Options menu, select Speech recognition } Create New 
      Speaker.

 5.  Enter the correct voice fi le name in the Your Name fi eld, and then 
      continue until the Audio Wizard Setup is complete.

 6.  Select Cancel and close the iCommunicator program.

 7.  You must run Audio Setup the fi rst time you use the restored S/V fi les.
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Delivering
     quick say messages, 3-13

E 
Elements
     iCommunicator program, 3-1
Exit iCommunicator program, 3-9

F
File
    menu, 3-3
Function Keys
    quick say messages, 3-12
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    exit, 3-9
    windows, 3-2
iCommunicator System
     starting, 3-1
iCommunicator Windows
     control window, 3-2
     elements, 3-2
     minimizing and restoring, 3-9
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Locking
     signing window, 3-18

I – 1



The iCommunicator 
User Guide

M
Menu
     actions, 3-5
     fi le, 3-3
     options, 3-4
      views, 3-3
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